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Abstract

Fahrer von elektrischen Rollstiihlen kdnnen oftmals nicht ermitteln, welche
Reichweite sie noch zurilicklegen konnen. Der Grund ist das Fehlen einer Kilome-
teranzeige. Um das Problem zu |6sen, wurde ein GPS-basierter Prototyp in Form

einer App fir das Betriebssystem Android entwickelt.

Die Gliederung dieser Masterarbeit besteht hauptsachlich aus drei Teilen. An-
fanglich wird das Konzept der App beschrieben. So werden zum Beispiel die wei-
teren Funktionen sowie der grafische Aufbau naher erlautert. Im darauf folgen-
den Teil wird die Umsetzung des Konzepts behandelt. Im dritten Teil folgt
schliefilich die Evaluation der Umsetzung. Die Zielsetzung der Arbeit war die Ent-
wicklung eines Prototyps, um eine Reichweitenermittlung von elektrischen Roll-

stuhlen zu erreichen.
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1 Einleitung

Der Autor dieser Masterarbeit hatte sich zum Ziel gesetzt, eine Losung fir das
Problem zu entwickeln, dass bei elektrischen Rollstiihlen aufgrund der fehlenden
Kilometeranzeige oftmals keine Aussage darliber getroffen werden kann, welche
Reichweite mit der jeweiligen Akkuladung noch zuriickgelegt werden kann. Bei
elektrischen Rollstihlen ist im Akku die fiir die selbststindige Fortbewegung not-

wendige Energie gespeichert.

Als Losungsansatz wurde die Entwicklung eines Prototyps fiir das kostenlose
Smartphone-Betriebssystem Android gewahlt. Da die Berechnung unter anderem
der zuriickgelegten Strecke mit Hilfe des GPS erfolgt, wurde zunachst das Smart-
phone als grundlegende Plattform ausgewahlt, da in den meisten Fallen bereits
ein GPS-Empfanger integriert ist. Als weitere Rahmenbedingung wurde der Pro-
totyp fiir Android entwickelt, da das Betriebssystem einen hohen Marktanteil be-
sitzt und entsprechende Smartphones in einer groBen Preisspanne erhaltlich
sind. Diese Griinde sprechen insgesamt dafiir, dass der entwickelte Prototyp (im

Folgenden RolliApp genannt) fiir eine moglichst groBe Nutzerzahl zugénglich ist.

In den Kapiteln 2.1, 2.2, 2.3 und 2.4 werden zunachst die Idee hinter RolliApp
und der Funktionsumfang noch einmal genauer erlautert, eine dhnliche App im

Android Market untersucht sowie die Rahmenbedingungen beschrieben.

Daraufhin werden in den Kapiteln 2.5 und 2.6 samtliche Arbeitsschritte, die fir
das Aufsetzen der Entwicklungsumgebung erforderlich sind, aufgefiihrt und die

beiden Méglichkeiten zum Testen des Prototyps vorgestellt.



In den Kapiteln 2.7, 2.8, 2.9 und 2.10 folgen zunachst grundlegende Aspekte be-
ziglich des grafischen und funktionalen Aufbaus von RolliApp, bevor in den
Kapiteln 3.1, 3.2 und 3.3 sowie 3.5, 3.6, 3.7, 3.8 und 3.9 mit der Erlduterung der
jeweiligen Umsetzung fortgefahren und im Kapitel 3.11 beschrieben wird, wie

eine in der Entwicklung abgeschlossene Android-App verdéffentlicht wird.

Bevor im sechsten Kapitel ein Ausblick diese Arbeit damit abschlieBt, wie die wei-
tere Entwicklung von RolliApp aussehen kénnte, wird im flinften Kapitel noch ein
Fazit gezogen, sowie im vierten Kapitel mit Hilfe einer Versuchsreihe belegt, dass

die Berechnung der streckenbezogenen Funktionen korrekt funktioniert.



2 Konzept

2.1 Grundsdtzliche Idee

Die Idee zu RolliApp entstand dadurch, dass beim elektrischen Rollstuhl des Au-
tors dieser Masterarbeit keine genaue Aussage Uber den Ladezustand des Akkus
und damit Uber die verbleibende Reichweite getroffen werden kann. Die Anzeige
des Ladezustands erfolgt wie in Abbildung 1 dargestellt lediglich mit Hilfe von
zehn farbigen Balken, deren verbleibende Anzahl den aktuellen Ladezustand

widerspiegeln.

Abbildung 1: Bedienelement Rollstuhl



Der Losungsansatz wurde in dieser Arbeit (iber Eingabe einer individuellen Kilo-
meterzahl realisiert. Um erstmalig zu bestimmen, welche Reichweite mit der vol-
len Akkuladung zuriickgelegt werden kann, sind beispielsweise mehrere vollstan-
dige Entladevorgange beziehungsweise Fahrten mit dem Rollstuhl mit anschlie-
Render tabellarischer Auswertung denkbar. Die selbst definierte Reichweite wird
daraufhin an die zuriickgelegte Strecke angepasst. Wurde der Akku beispielswei-
se wieder aufgeladen, kann der Nutzer zuséatzlich den Wert auf die vorher defi-

nierte maximale Reichweite zuriicksetzen.

Urspringlich bestand die Idee darin, dass der Nutzer optional die Méglichkeit
hat, das Rollstuhlmodell auszuwahlen und somit die flir das jeweilige Modell ent-
sprechende Reichweite ibernommen wird. Aufgrund der gewahlten Umsetzung

ist RolliApp jedoch auch theoretisch flir Nicht-Rollstuhlfahrer geeignet.



2.2 Funktionsumfang

Der Ubersicht halber folgt zunichst die Auflistung sdmtlicher Anzeigen von

RolliApp, unterteilt nach Haupt- und Zusatzfunktionen:

Hauptfunktion — Verbleibende Strecke

Zusatzfunktionen — Aktuelle Geschwindigkeit, Zuriickgelegte Strecke, Uhrzeit,

Zeit seit Start

Zusatzlich zur Hauptfunktion bietet RolliApp weitere Funktionen an, die sowohl

in der App als auch im Folgenden thematisch unterteilt sind.

Geschwindigkeit — Mit Hilfe einer ganzzahligen Kilometerangabe wird die aktuel-

le Geschwindigkeit des Nutzers ausgegeben.

Strecke — Beziiglich der Strecke gibt es zwei verschiedene Anzeigen. Einerseits
wird die verbleibende Reichweite und andererseits die zurlickgelegte Strecke er-
mittelt und dargestellt. Genau wie die verbleibende Reichweite lasst sich auch
die zuriickgelegte Strecke zurlicksetzen. Der jeweils aktuelle Wert bleibt sowohl

beim Pausieren als auch beim SchlieRen der App erhalten.

Zeit — Hier wird sowohl die Uhrzeit als auch die Zeit dargestellt, seit der die App
aktiv ist. Der Nutzer hat ebenfalls die Moglichkeit, letztere Anzeige zuriickzuset-
zen. Weiterhin bleibt der Wert beim Pausieren und SchlieRen der App bestehen.
Die jeweilige Darstellung der Zeit (an dieser Stelle sei auf Abbildung 6 verwiesen)
wurde auch aus dem Grund umgesetzt, da es moglicherweise Nutzer beziehungs-
weise Rollstuhlfahrer gibt, fiir die die Zeit beispielsweise krankheitsbedingt eine

Rolle spielt.
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2.3 Android Market

Beim Android Market handelt es sich ebenfalls um eine App, die einen Bestand-
teil des Betriebssystems darstellt. Mit ihrer Hilfe hat der Nutzer die Mdglichkeit,

Apps aus einem zentralen Repository herunterzuladen.

Hierflir muss sich der Entwickler zunachst registrieren und eine Gebihr in Hohe
von 25 US-Dollar entrichten. Daraufhin kdnnen Apps im Android Market kosten-
los angeboten werden. Sollen Apps jedoch kostenpflichtig bereitgestellt werden,
ist fir die Abwicklung zusatzlich die Registrierung bei Google Checkout notwen-
dig (Google A). Fir den Endkunden fallt jedoch lediglich gegebenenfalls fiir den
Erwerb der App eine Gebihr an (Google B). Seit Anfang des Jahres 2011 ist es zu-
dem moglich, den Android Market unter der Adresse
https://market.android.com/?hl=de auch ohne Android-Smartphone zu nutzen

(androidsmartphone.de).

Im Android Market lieferte eine anfangliche Suche nach dem Begriff Rollstuhl le-
diglich einen Treffer. Hierbei handelte es sich jedoch um eine App, die vegane Es-
sens- und Einkaufsmaoglichkeiten in Berlin auflistet. Die App wurde wahrschein-
lich als ein fur die Suche relevantes Ergebnis eingestuft, da im Beschreibungstext
das Wort rollstuhlgerecht im Zusammenhang mit den Filterungsméglichkeiten in-

nerhalb der App vorhanden ist.

Die Nutzung des Suchbegriffs wheelchair ergab 24 Treffer, die jedoch ihren Na-
men und Beschreibungen nach alle inhaltlich ebenfalls nicht den Anforderungen

entsprechen.
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Da die Hauptfunktion von RolliApp, die Anzeige der verbleibenden Reichweite,
auf ,,GPS“ basiert, erfolgte anschliefend eine dementsprechende Suchanfrage
mit circa 14.000 Treffern. Nun verhalt es sich leider so, dass der Android Market
lediglich die rudimentaren Filterungsmoglichkeiten ,,Preis”, ,Safesearch” und
»Sortieren nach” bietet. Von den ersten beiden Filtern wurde kein Gebrauch ge-
macht, um keine App auszuschlieBen. Die Sortierung der Trefferliste nach Rele-
vanz wurde belassen. Da es jedoch fiir den Autor dieser Masterarbeit unmaoglich
war, die grofRe Trefferzahl zu bewaltigen, wurde die erste Seite der Trefferliste
(24 Treffer) herangezogen. Hierbei wurden zunachst ebenfalls die Namen und
Beschreibungen betrachtet, bevor eine App (runtastic GPS Coach) genau unter-
sucht wurde. Die Ubrigen 23 Treffer deuteten weiterhin auf keinen Funktionsum-

fang hin, der iber den von runtastic GPS Coach hinausgeht.

Abbildung 2 zeigt zunachst den Hauptbildschirm der App:

x @ = 12:19
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00:00:00 £ 0.0 wn

Driicke um zu wechseln

0.00w . 0.0 2.

Start
GO . By
Session
o
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Session Karte Aktivitaten | Einstellungen
Abbildung 2: Hauptbildschirm
runtastic GPS Coach
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Runtastic GPS Coach ist eine Laufsport- und Fitnessapp, die vom 6sterreichischen
Unternehmen runtastic GmbH entwickelt wird. Zusatzlich wird die App auch fiir
die Produkte IPhone, BlackBerry und Windows Phone 7 angeboten

(runtastic GmbH A).

Wie in Abbildung 2 dargestellt ist, bietet runtastic GPS Coach in der kostenlosen

Variante folgende Funktionen, die mit denen von RolliApp vergleichbar sind:

* Zeit seit Start
* Zurlckgelegte Strecke

* Aktuelle Geschwindigkeit

Gegen eine Gebuhr in Hoéhe von 3,99 Euro werden zusatzlich die Funktionen
Sprachausgabe, Live Tracking, Verbindung mit Pulsgurt und GeoTagging unter-

stUtzt (runtastic GmbH B).

Die Anzeige der Durchschnittsgeschwindigkeit ergibt fiir elektrische Rollstiihle
keinen Sinn, da sie fiir gewdhnlich mit einer konstanten Hochstgeschwindigkeit
betrieben werden. Aus dem Grund wurde bewusst auf die Anzeige der Durch-

schnittsgeschwindigkeit verzichtet.

Der Funktionsumfang von runtastic GPS Coach reicht nicht aus, um alle Anforde-
rungen fir die Untersuchung der oben genannten Aufgabenstellung durchzufiih-
ren. Fiir die Untersuchung wurde daher ein Prototyp entwickelt, der Gber die re-
levanten Funktionen von runtastic GPS Coach verfiigt und darlber hinaus weite-

re relevante Funktionen, die speziell fiir Rollstuhlfahrer notwendig sind, erganzt.
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2.4 Rahmenbedingungen

Die Funktionen , Aktuelle Geschwindigkeit”, ,Verbleibende Strecke” und
»Zurlickgelegte Strecke” bendtigen jeweils den aktuellen Aufenthaltsort des Nut-
zers (siehe Abbildung 6). Bezliglich der Geschwindigkeit sind im Speziellen Stre-

cke und Zeit erforderlich, da mit ihnen die Geschwindigkeit berechnet wird.

Die bendétigten Informationen liefert beispielsweise das sogenannte GPS. GPS
steht fiir Global Positioning System und wurde urspriinglich vom US-Verteidi-
gungsministerium fur militarische Zwecke entwickelt. Seit der Abschaltung der
kiinstlichen Signalverschlechterung im Jahr 2000 hat sich GPS jedoch auch im zi-
vilen Bereich durchgesetzt und kommt beispielsweise in Navigationssystemen
zum Einsatz. Nichtsdestotrotz weist GPS im zivilen Bereich immer noch eine ge-
wisse Ungenauigkeit auf, die bei der Umsetzung von RolliApp

(Kapitel 3.6 und 3.7) eine Rolle spielte. Das System besteht aus mindestens 24
Satelliten und arbeitet mit Hilfe von Laufzeitmessungen (Kohne; W6Rner). Da
GPS heutzutage bereits in den meisten Smartphones integriert ist, stellen die Ge-
rate eine geeignete Grundlage fiir den Prototypen dar. Die mobilen Eigenschaf-
ten des Smartphones, insbesondere das GPS, eignen sich fiir die Erstellung einer
Softwarelosung, die als ein quasi eingebettetes System mit elektrischen Rollstiih-

len mitgeflihrt werden kann.

Als Entwicklungs- und Testumgebung wurde eine Eclipse-Umgebung mit einem
Smartphone des Herstellers High Tech Computer Corporation (HTC) verwendet.
Das Smartphone wurde auBerdem fiir die Testfahrten mit dem elektrischen Roll-
stuhl verwendet. Das Modell hat das bendtigte GPS integriert und basiert auf

dem Betriebssystem Android.
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Entwickelt wird Android von der Open Handset Alliance, dem Zusammenschluss
von 84 Unternehmen, darunter Google, HTC, Intel und T-Mobile
(Open Handset Alliance A). Android wurde fir mobile Gerate konzipiert und am

21.10.2008 veroffentlicht (Google C).

Auf Android als Betriebssystem fir die Entwicklungsplattform wurde aus folgen-

den Griinden zuriickgegriffen:

Android hatte der NPD Group zufolge im zweiten Quartal 2011 einen US-Markt-
anteil von 52 Prozent (BIG SCREEN Internetportal). Auch beziglich des Anschaf-
fungspreises lasst sich eine gewisse Marktdominanz erkennen, da beispielsweise
bei Amazon fir die Neuanschaffung eines Android-Smartphones aufgrund der
Herstellervielfalt von 65 bis 580 Euro bezahlt werden kdnnen (Stand 24.08.2011).
Diese beiden Umstande tragen moglicherweise dazu bei, dass RolliApp durch die
Veroffentlichung fiir eine grolRe Nutzerzahl zuganglich ist. Weiterhin wurde An-
droid als offenes Betriebssystem entworfen und baut auf einem Linux Kernel auf.
Daraus ergibt sich, dass theoretisch jede Person eine App entwickeln und verof-
fentlichen kann, solange sie nicht gegen die Geschafts- und Programmrichtlinien

des Android Markets verstoRt (Open Handset Alliance B).
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2.5 Entwicklungsumgebung

Die Entwicklung einer Android-App erfolgt ausschlie8lich in der Programmier-
sprache Java. Java-Software hat den Vorteil, dass sie plattformunabhangig ist. Die
Unabhangigkeit wird dadurch erreicht, dass aus dem entwickelten Code nicht der
Maschinencode sondern der sogenannte Bytecode erzeugt wird. Im Gegensatz
zum Maschinencode fiir eine spezielle Plattform (zum Beispiel Windows) steht
der Bytecode, der wiederum von der sogenannten Java Virtual Machine ausge-
flihrt wird und die zum Beispiel sowohl fiir Windows als auch fiir Mac OS verfiig-
bar ist (Galileo Press). Demzufolge muss fiir ein Android-Smartphone ebenfalls
die Java Virtual Machine verfiigbar sein. Die Aufgabe ibernimmt die Dalvik Virtu-
al Machine. Hierbei handelt es sich jedoch streng genommen nicht um die Java
Virtual Machine, da der Java-Bytecode intern noch einmal umgewandelt wird

(DalvikVM.com).

Um fiir die Entwicklung eine vollstandige Umgebung aufzusetzen sowie das in
dieser Masterarbeit beschriebene Projekt zu importieren, sind folgende Arbeits-

schritte notwendig:

Zunachst wird das sogenannte Java Development Kit (JDK) benotigt. Es handelt
sich dabei um ein Software Development Kit (SDK), das fiir die Entwicklung mit
Java vorausgesetzt wird und unter anderem auch eine Java-Laufzeitumgebung

beinhaltet. Das JDK ist ebenfalls plattformunabhangig.
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Das JDK beziehungsweise die Laufzeitumgebung ist ohnehin fir die Entwicklungs-
umgebung Eclipse notwendig, die wiederum auf Java basiert. Mit der Hilfe von
Eclipse kann Software unter anderem in Java entwickelt werden. Die Entwick-
lungsumgebung ist fiir verschiedene Plattformen und Programmiersprachen er-
haltlich. Fir die Android-Entwicklung wird ,,Eclipse Classic” empfohlen
(Android.com A). Zwar wird Eclipse nicht zwingend benétigt, sondern es kann
prinzipiell eine beliebige Entwicklungsumgebung genutzt werden. Eclipse bietet
zusammen mit den sogenannten Android Development Tools (ADT) verschiedene
Vorteile wie zum Beispiel die Entwicklung einer grafischen Nutzeroberflache und

das exportieren einer fertiggestellten App (Android.com B).

ADT ist ein Plug-in fiur Eclipse, das wie beschrieben verschiedene Schritte bei der
Entwicklung erleichtert. Das Plug-in wird Giber den Update Manager von Eclipse
installiert. Das erforderliche Fenster fiir die Installation befindet sich unter
»,Help>Install New Software>Add”“. Durch Eingabe eines beliebigen Namens, der
URL https://dl-ssl.google.com/android/eclipse/ und Bestatigen der daraufhin er-
scheinenden Fenster ist die Installation fast abgeschlossen. Schlielllich bedarf es
zusatzlich der Angabe des SDKs, die unter ,, Window>Preferences>Android“ zu

machen ist (Android.com C).

Ob die Android-Entwicklung in Eclipse oder einer anderen Entwicklungsumge-
bung erfolgt, es wird auf jeden Fall das sogenannte SDK Starter Package benotigt.
Dabei handelt es sich lediglich um ein Basis-SDK, das um weitere Komponenten
erweitert werden muss. Zwingend erforderlich sind jedoch die SDK Platform-
Tools und eine SDK Platform (Android.com D). Letztere stellt die Android-Version
dar, die fir die jeweilige App mindestens vorausgesetzt wird. Da RolliApp jedoch
keine Funktion bietet, die eine hohe Android-Version notwendig macht, hat sich
der Autor aufgrund der folgenden Statistik flir die Android-Version 2.1 entschie-
den (Android.com E).
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Android 2.3 - 2.3.2

Android 2.2 —

Android 2.1

Abbildung 3: Statistik Android-Versionen

Das Importieren des Projekts dieser Masterarbeit erfolgt in Eclipse tber
»File>Import>General>Existing Projects into Workspace” und anschlieender An-
gabe des Wurzelverzeichnisses. Optional ldsst sich zudem auswahlen, dass eine

Kopie im Workspace von Eclipse erstellt wird.

Die vollstandig aufgesetzte Entwicklungsumgebung inklusive des importierten

Projekts ist in Abbildung 4 dargestellt.

e Y T a2

Abbildung 4: Eclipse RolIiA;)p

Eine detaillierte Installationsanleitung ist unter der URL

http://developer.android.com/sdk/installing.html zu finden.
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2.6 Testmoglichkeiten

Dem Testen einer App kommt wahrend der Entwicklung eine besondere Bedeu-
tung zu. Grundsatzlich bestehen hierbei zwei Moglichkeiten. Einerseits enthalt
das SDK den Android-Emulator. Mit Hilfe des Emulators lassen sich alle Hard- und
Softwarefunktionen eines Android-Smartphones aulRer der Telefonfunktion auch
ohne ein physisches Testgerat nutzen (Android.com F). Die Einrichtung

des Emulators erfolgt in Eclipse unter

,Window>Android SDK and AVD Manager>Virtual devices>New"“. Neben des Na-
mens und der GroRe der virtuellen SD-Karte wird die Angabe bendtigt, welche
Android-Version emuliert werden soll. Das SDK Starter Package muss jedoch zu-
vor um die Version erweitert worden sein. Bevor eine App veroffentlich wird,
sollte jedoch der Test auf einem physischen Gerat erfolgen, um unter anderem
sicherzustellen, dass die Nutzeroberflache korrekt dargestellt wird

(Android.com G). Abbildung 5 zeigt den Android-Emulator:
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2.7 Hauptbildschirm

& F gl = 1:06PM

Abbildung 6: Hauptbildschirm

Zunachst wurde die Farbe Orange fiir den Hintergrund gewahlt. Orange zahlt zu
den warmen Farben, wirkt positiv und wird weiterhin, auch bezlglich

der App, mit Mode und Wandel assoziiert

(Lichtkreis.at - Spirituelle Wegbegleitung durch Information, Wissen und
Lichtarbeit). Als Schriftfarbe wird Schwarz verwendet, da somit zwischen den bei-
den Farben ein grolRer Kontrast besteht und eine gute Lesbarkeit gewahrleistet
ist (FIT far Usability. Konzeption, Design & WebBuilding by Peter Hunkirchen.).
Da es sich bei RolliApp um einen erweiterten Tacho handelt, sollte die Schriftart
durchgangig ein digitales Aussehen erhalten. Daher wurde die Schriftart Digital
Dream Narrow von ,Schriftarten.org”, die in Abbildung 9 dargestellt ist, kosten-

los heruntergeladen und verwendet.
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Wie bereits in Kapitel 2.2 beschrieben, werden verschiedene Funktionen gebo-
ten, die sinnvoll auf dem Hauptbildschirm angeordnet werden mussten. Da ur-
spriinglich lediglich die Bereiche Geschwindigkeit und Strecke geplant waren,
wurde der Zeitbereich am unteren Bildschirmrand positioniert. Weiterhin wurde
der Geschwindigkeitsbereich aufgrund der Zahl an Anzeigen am Anfang platziert,
um ein geschlossenes Gesamtbild herzustellen. Es bestand zwar zusatzlich die
Moglichkeit, zwecks eines groReren Sichtbereichs die Statusleiste am oberen
Bildschirmrand auszublenden, doch sie wurde unter anderem aufgrund der Emp-

fangs- und Akkuanzeige beibehalten.
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2.8 Einstellungsbildschirm

Bezliglich der Hintergrundfarbe, Schriftart und Statusleiste galten die gleichen
Grinde der Umsetzung wie auch schon fir den Hauptbildschirm. Lediglich in der

Anordnung gibt es einige Unterschiede.

= 1:07PM

Abbildung 7:
Einstellungsbildschirm

Zunachst existiert keine Geschwindigkeitseinstellung. Fir die verbleibende Stre-
cke waren sowohl ein Eingabefeld als auch eine Checkbox vorgesehen. Das Einga-
befeld dient wie bereits in Kapitel 2.1 beschrieben der Eingabe einer individuel-
len Reichweite. Die Checkbox kann markiert werden, um den Wert zuriickzuset-
zen. Die Moglichkeit besteht zusatzlich fir die zurlickgelegte Strecke sowie die
Zeit seit Start. Mit Hilfe des OK-Buttons gelangt der Nutzer zurlick zum Haupt-
bildschirm (Gber die Men(taste des Android-Smartphones kann der Einstellungs-

bildschirm aufgerufen werden).
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2.9 Icon und Schriftart

Weiterhin wurde fir die Darstellung der App unter anderem auf dem Home
Screen eines Android-Smartphones ein Icon bendtigt. Der Wunsch des Autors
dieser Masterarbeit war moglichst ein modernes Rollstuhl-Motiv. Bei Fotolia, ei-
ner internationalen Bildagentur, wurde der Autor schliefRlich fiindig und hat das
Icon (siehe Abbildung 8) in einer geeigneten Ausgangs-Auflésung erworben
(Fotolia). Der Hintergrund des heruntergeladenen Icons wurde schlieflich mit
Photoshop transparent gemacht, auf die jeweils benotigte Auflosung herunterge-

rechnet (siehe Kapitel 3.3) und als PNG-Datei gespeichert.

Abbildung 8: Icon

CLILITAL DREAM NARRUW

Abbildung 9: Schriftart
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2.10 Funktionstabelle

1. Start

Ab 2. Start

Ende

Eingabe
Verblei-
bende

Strecke

Reset
Verblei-
bende
Strecke

Reset
Zuriickge-
legte
Strecke

Reset Zeit
seit Start

Aktuelle
Geschwin-
digkeit

Verblei-
bende
Strecke =
0

Verblei-
bende
Strecke
speichern

Verblei-
bende
Strecke
laden

Verblei-
bende
Strecke =
Nutzer-
eingabe

Zurickge-
legte
Strecke =
0

Zuriickge-
legte
Strecke
speichern

Zurickge-
legte
Strecke
laden

Uhrzeit

Zeit seit
Start=0

Zeit seit
Start
speichern

Zeit seit
Start
laden

Tabelle 1: Logik
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3 Umsetzung

Die im Kapitel beschriebenen Codeausschnitte stammen aus dem Eclipse-Projekt,

das sich auf dem beigefligten Datentrager befindet.

3.1 Hauptbildschirm

Die grafische Umsetzung erfolgte in der HTML-dhnlichen Auszeichnungssprache
Extensible Markup Language (XML) (SELFHTML e.V.). Es besteht jedoch auch die
untypische Moglichkeit, die grafische Umsetzung einer Android-App direkt in
Java zu tatigen (Android.com H). Somit geschah die Umsetzung des Hauptbild-
schirms in der Datei main.xml, die sich innerhalb der Projektstruktur im Ordner

RolliApp/res/layout/ befindet (Abbildung 4).

& F all == 1:06PM

1

2 6
5

8 3
4

7

Abbildung 10: Hauptbildschirm
beschriftet
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1 - Hintergrundfarbe

Zunachst wurde die Hintergrundfarbe, die in Kapitel 2.7 definiert wurde, in der

Entwicklungsumgebung folgendermallen umgesetzt:

android:background="#FFA500"

Hierbei wurde der Wert fiir die Farbe in hexadezimaler Schreibweise angegeben.
In dem Fall steht das ,,FF” fiir einen maximalen Rotanteil, das , A5“ fir einen be-
stimmten Griinanteil und das ,,00“ fir keinen Blauanteil. Die Kombination ergab

schlieBlich die gewlinschte Hintergrundfarbe (dauerstress.de).

2 — Text, Textfarbe und Textgrofle

Nach dem Definieren der Hintergrundfarbe erfolgte die Umsetzung der Schrift
(siehe ebenfalls Kapitel 2.7), hier am Beispiel des Wortes Geschwindigkeit. So-
wohl die Realisation des eigentlichen Textes als auch der Textfarbe und -groRe ist

im folgendem Codeausschnitt dargestellt:

android:text="Geschwindigkeit"
android:textColor="#000000"

android:textSize="24sp"

Das Besondere hierbei ist die verwendete Einheit fir die TextgroRe. Die Verwen-
dung von sogenannten Scale-Independent Pixels erlaubt sowohl die Anpassung
an die Dichte des jeweiligen Bildschirms als auch an die Nutzereinstellung der

SchriftgroRe (Android.com 1).
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3 — Positionierung links und unterhalb

Fir die grafische Umsetzung kamen auch direkte Positionsangaben zur Anwen-

dung, im folgendem Beispiel flir den Wert Zeit seit Start:

android:layout_tolLeftOf="@+id/sinceStartUnit"

android:layout_below="@+id/timeOfDay"

Das Beispiel verdeutlicht aulerdem, warum es notwendig ist, dass jedem Ele-

ment eine eindeutige ID zugewiesen wird.

4 — Ausrichtung ganz rechts und unten

Zusatzlich zur direkten Positionierung wurde im folgenden Beispiel auch die Ein-

heit von ,Zeit seit Start” an jener ausgerichtet:

android:layout_alignParentRight="true"

android:layout_alignBaseline="@+id/sinceStart"

Im Beispiel wurde zunachst mit Hilfe der booleschen Variable das Element am
rechten Rand des Eltern-Elements, hier der rechte Bildschirmrand, ausgerichtet.
Zusatzlich wurde fir die Ausrichtung an der Unterkante des Elements mit der ID

sinceStart gesorgt.
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5 — Ausrichtung rechts

Der Vollstandigkeit halber ist im Folgenden exemplarisch die Ausrichtung des
Wertes fir die aktuelle Geschwindigkeit am Element mit der ID sinceStart aufge-

fuhrt:

android:layout_alignRight="@+id/sinceStart"

6 — Horizontale Zentrierung

Mit Hilfe des folgenden Codeausschnitts wurde fiir die horizontale Zentrierung,

hier des Wortes Geschwindigkeit, gesorgt:

android:layout_centerHorizontal="true"

7 — Vertikale Zentrierung

Demgegeniiber musste die vertikale Zentrierung im Folgenden lediglich einmal

flir das gesamte Eltern-Element definiert werden:

android:gravity="center_vertical"
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8 — Abstand oben und rechts

SchliefRlich zeigt folgendes Beispiel, in dem Fall der Wert Zeit seit Start, die Ver-

wendung von Abstanden:

android:layout_marginTop="12dip"

android:layout_marginRight="6dip"

Bei der Einheit dip (oder auch dp) handelt es sich um sogenannte Density-Inde-
pendent Pixels, die immer dann verwendet werden sollte, wenn keine Schriftgro-

Re definiert wird.
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3.2 Einstellungsbildschirm

Die Umsetzung erfolgte in der XML-Datei RolliApp/res/layout/settings.xml
(Abbildung 4).

= 1:07PM

Abbildung 11:
Einstellungsbildschirm beschriftet

1 - Eingabefeld

Flr den Einstellungsbildschirm wurde zunachst das Eingabefeld mit den Beson-
derheiten, dass es sich um ein Nummern-Eingabefeld mit einer maximalen Lange

von zwei Nummern handelt, folgendermallen umgesetzt.

android:inputType="number"

android:maxLength="2"
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2 — Checkbox

AuBerdem wurden mehrere Checkboxen durch Verwendung von ,,<CheckBox/>“

realisiert.

3 — Knopf

SchlieRlich wurde mit Hilfe von ,,<Button/>“ ein Knopf umgesetzt.
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3.3 Icon und Schriftart

Beziiglich des Icons war die Grundvoraussetzung, dass das PNG-Format verwen-
det wird (Android.com J). Da Android-Smartphones tber verschiedene Bild-
schirm-Dichten verfligen, sollte das gewlinschte Icon jeweils in der Auflosung
72x72 px, 48x48 px sowie 36x36 px vorliegen (Android.com K). Die bearbeiteten
Icons wurden daraufhin in die jeweils dafiir vorgesehenen Ordner innerhalb der
Projektstruktur von Eclipse kopiert. Dabei handelte es sich um die Ordner
drawable-hdpi, drawable-Idpi und drawable-mdpi unterhalb von ,,RolliApp/res”
(Abbildung 4). SchlieRlich musste das Icon in der Datei AndroidManifest.xml an-
gegeben werden. Hierzu bendtigte jedes der drei Icons den gleichen Datei-

namen, damit der folgende Codeausschnitt korrekt funktioniert:

android:icon="@drawable/icon

Die gewlinschte Schriftart fiir den Haupt- und Einstellungsbildschirm lag im TTF-
Format vor. Die Datei wurde daraufhin in den Ordner
RolliApp/assets/fonts/ kopiert und mit Hilfe der folgenden Methode auf die ent-

sprechenden Elemente, hier das Wort Geschwindigkeit, angewendet:

private void setupFont() {

Typeface font = Typeface.createFromAsset(getAssets(),

"fonts/DigitaldreamNarrow.ttf");

TextView speedAreaTextView = (TextView) findViewByld(R.id.speedArea);

speedAreaTextView.setTypeface(font);

}
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Innerhalb der Methode setupFont wurde zunachst das Typeface-Objekt ,,font”
erzeugt und diesem die Datei DigitaldreamNarrow.ttf zugewiesen. Zusatzlich
wurde das Textview-Objekt speedAreaTextView erschaffen und diesem das Ele-
ment mit der ID speedArea zugewiesen. Schliefllich wurde die gewlinschte
Schriftart auf alle entsprechenden Elemente des Haupt- und Einstellungsbild-

schirms angewendet.
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3.4 Zusammenfassung der grafischen Umsetzung

Verwendung Attribut

Abstand nach oben android:layout_marginTop
Abstand nach rechts android:layout_marginRight
Ausrichtung am rechten Rand android:layout_alignParentRight
Ausrichtung am rechten Rand von ID android:layout_alignRight
Ausrichtung am unteren Rand von ID android:layout_alignBaseline
Hintergrundfarbe android:background

Horizontale Zentrierung android:layout_centerHorizontal
Icon android:icon

ID android:id

Maximale Lange des Eingabefelds android:maxLength
Positionierung links von ID android:layout_tolLeftOf
Positionierung unterhalb von ID android:layout_below

Text android:text

Textfarbe android:textColor

TextgroRe android:textSize

Typ des Eingabefelds android:inputType

Vertikale Zentrierung android:gravity

Tabelle 2: Zusammenfassung Umsetzung Haupt- und Einstellungsbildschirm
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3.5 Aktuelle Geschwindigkeit

Die Datei Main.java, die unter anderem den entsprechenden Code beinhaltet,

befindet sich im Ordner RolliApp/src/de.stapelfeldtonline.rolliapp/.

private void updateSpeedTextView(Location location) {

TextView speedTextView = (TextView) findViewByld(R.id.speed);

Float speedTextViewFloat = location.getSpeed() * 3.6f;
String speedTextViewString = String.format("%.0f", speedTextViewFloat);
speedTextView.setText(speedTextViewString);

}

public void onlLocationChanged(Location location) {
updateSpeedTextView(location);

}
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Zunachst wurde innerhalb der Methode updateSpeedTextView das Textview-Ob-
jekt speedTextView erzeugt und diesem das Element mit der ID speed zugewie-
sen. Anschliellend erfolgte die Berechnung und Darstellung des eigentlichen
Wertes der aktuellen Geschwindigkeit. Einerseits wurde hierfiir das Float-Objekt
speedTextViewFloat erschaffen und diesem mit Hilfe der getSpeed-Methode die
aktuelle Geschwindigkeit zugewiesen. Zusatzlich folgte eine Multiplikation, da
der urspriinglich zurtickgegebene Wert die Einheit m/s besitzt. Andererseits wur-
de dieser Wert daraufhin formatiert, umgewandelt und wiederum dem String-
Objekt speedTextViewString zugewiesen. Schliefllich wurde der Wert auf das ein-

gangs erzeugte Textview-Objekt angewendet.

Die Methode onlLocationChanged sorgt daraufhin dafiir, dass bei jeder Anderung
des Aufenthaltsorts die zuvor beschriebene Methode updateSpeedTextView auf-

gerufen wird.
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3.6 Verbleibende Strecke

Der folgende Codeausschnitt befindet sich ebenfalls in der Datei Main.java
und der darauf folgende in der Datei
RolliApp/src/de.stapelfeldtonline.rolliapp.remainingdistance/Remaining-

DistanceCalculator.java.

Darstellung

private void updateRemainingDistanceTextView() {

TextView remainingDistanceTextView = (TextView)

findViewByld(R.id.remainingDistance);

float remainingDistance =
RemainingDistanceConverter.convertMetersToKilometers(GlobalAccessMana-

ger.getinstance().getRemainingDistanceCalculator().getRemainingDistance());
String remainingDistanceString = String.format("%.0f", remainingDistance);

remainingDistanceTextView.setText(remainingDistanceString);

}

public void onLocationChanged(Location location) {

GlobalAccessManager.getinstance().getRemainingDistanceCalculator().update-

CurrentLocation(location);

updateRemainingDistanceTextView();

}
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Zunachst ist die Methode updateRemainingDistanceTextView dhnlich zur im vor-
angegangenen Kapitel beschriebenen Methode updateSpeedTextView aufge-

baut.

Ebenso verhalt es sich mit der Methode onLocationChanged, mit dem Unter-
schied, dass die eigentliche Berechnung der verbleibenden Reichweite nicht di-
rekt in dieser Java-Datei sondern innerhalb der externen Methode
updateCurrentLocation geschieht. Zu dem Zweck wurde ein
GlobalAccessManager verwendet, der den Zugriff auf verschiedene Dateien er-

moglicht.

Berechnung

public void updateCurrentLocation(Location currentLocation) {
if (lastLocation != null) {
float distance = lastLocation.distanceTo(currentLocation);

float accuracy = currentLocation.getAccuracy();

if (distance >= accuracy) {

remainingDistance -= distance;

this.lastLocation = currentLocation;
}

}else {

this.lastLocation = currentlLocation;
}

}
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public float getRemainingDistance() {
return Math.max(remainingDistance, 0);

}

Die Methode updateCurrentLocation enthalt zwei If- und eine Else-Anweisung.
Immer dann wenn die sogenannte lastLocation ungleich null ist, werden zwei Be-
fehle ausgefiihrt. Zum einen wird die Distanz zwischen der last- und der
currentLocation vom Float-Wert distance subtrahiert. Zum anderen wird die Ak-
kuratheit der currentLocation abgefragt. Weiterhin wird gepriift, ob die berech-
nete Distanz grofer als die Akkuratheit ist und gegebenenfalls die Distanz von
der gesamten verbleibenden Reichweite subtrahiert sowie die current- als
lastLocation gespeichert. Andernfalls wird lediglich die current- als lastLocation

gespeichert.

Die Akkuratheit hangt mit der Genauigkeit des GPS-Signals zusammen. Das Signal
hat eine bestimmte Ungenauigkeit, die dazu fiihrt, dass obwohl das Smartphone
nicht vom Ort wegbewegt wird, der GPS-Empfanger bei wiederholten Messun-
gen dennoch ungenaue Koordinaten in einem bestimmten Umkreis liefert. Die
Akkuratheit gibt hierbei an, welche Abweichungen von der echten Position des
Smartphones maximal auftreten konnen. Werden zwei Messwerte verglichen
und der zweite liegt innerhalb des Ungenauigkeits-Umkreises, kann keine genaue
Aussage dariiber getroffen werden, ob das Smartphone seine Position geandert
hat. Liegt die zweite Messung jedoch auBerhalb des Umkreises, dann ist es wahr-

scheinlich bewegt worden.

Die Methode getRemainingDistance gibt schlieBlich den Wert remainingDistance
zurlick, der wiederum in der eingangs beschriebenen Methode

updateRemainingDistanceTextView bendtigt wird.
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3.7 Zuriickgelegte Strecke

Da die Funktionen beziiglich der Strecke sehr dhnlich zueinander aufgebaut sind,
befindet sich auch der entsprechende Codeausschnitt in den beiden selben Da-

teien, die bereits zuvor genannt wurden.

Darstellung

private void updateCoveredDistanceTextView() {

TextView coveredDistanceTextView = (TextView)

findViewByld(R.id.coveredDistance);

float coveredDistance =
RemainingDistanceConverter.convertMetersToKilometers(GlobalAccessMana-

ger.getinstance().getRemainingDistanceCalculator().getCoveredDistance());
String coveredDistanceString = String.format("%.3f", coveredDistance);

coveredDistanceTextView.setText(coveredDistanceString);

}

public void onlLocationChanged(Location location) {

GlobalAccessManager.getinstance().getRemainingDistanceCalculator().update-

CurrentLocation(location);

updateCoveredDistanceTextView();

}
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Die Methode updateCoveredDistanceTextView unterscheidet sich im Wesentli-
chen zur entsprechenden Methode im vorangegangenen Kapitel dadurch, dass
der in der Berechnung zurlickgegebene Wert coveredDistance mit Hilfe der Me-

thode getCoveredDistance in der vorgesehenen Textview dargestellt wird.

Bei jeder Anderung des Aufenthaltsorts wird wiederum die entsprechende

Update-Methode aufgerufen.

Berechnung

public void updateCurrentLocation(Location currentLocation) {
if (lastLocation != null) {
float distance = lastLocation.distanceTo(currentLocation);

float accuracy = currentLocation.getAccuracy();

if (distance >= accuracy) {

coveredDistance += distance;

this.lastLocation = currentLocation;

}
}else {

this.lastLocation = currentLocation;

}
}
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public float getCoveredDistance() {

return coveredDistance;

}

Die Berechnung der zuriickgelegten Strecke erfolgt dabei innerhalb der Methode
updateCurrentLocation durch Addition der ermittelten Distanz mit dem Wert
coveredDistance. Das geschieht ebenfalls jedoch immer nur dann, wenn die ent-
sprechende Distanz groRer als die Akkuratheit ist. Diese Uberpriifung wurde aus
dem Grund umgesetzt, um Ungenauigkeiten bezliglich der Positionsbestimmung
weitestgehend zu vermeiden. Beispielsweise wiirde eine Anderung des Aufent-
haltsorts um einen Meter bei einer Akkuratheit von mehr als einem Meter igno-
riert werden. Die Einschrankung wurde jedoch zwecks einer grofleren Messge-

nauigkeit in Kauf genommen.
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3.8 Uhrzeit

Die beiden im Wesentlichen fiir die Uhrzeit zustandigen Methoden befinden sich

in der Datei RolliApp/src/de.stapelfeldtonline.rolliapp.clock/Clock.java.

private void updateGui() {

CharSequence timeString = DateFormat.format("kk:mm",

System.currentTimeMiillis());

if (imeOfDayTextView != null) {

timeOfDayTextView.setText(timeString);
}
}

public void resume() {
if (handler == null) {
handler = new Handler();

handler.postDelayed(task, REFRESH_TIME);

}

updateGui();

}
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Zunachst sorgt die Methode updateGui dafiir, dass die aktuelle Uhrzeit des Be-
triebssystems auf die entsprechende Textview angewendet wird. Hierflir wird im
Detail das Charsequence-Objekt timeString erzeugt, diesem die formatierte Uhr-
zeit zugewiesen und das Objekt daraufhin auf die Textview timeOfDayTextView

angewendet.

Die Methode resume ist der zuvor beschrieben Methode insofern libergeordnet,
als dass sie beispielsweise das Aktualisierungsintervall REFRESH_TIME beinhaltet.
Die Aktualisierung findet mintlich statt. Das bedeutet jedoch auf der anderen
Seite, dass ein Sprung zur folgenden Minute innerhalb der App nicht unbedingt

synchron zur tatsachlichen Uhrzeit erfolgen muss.
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3.9 Zeit seit Start

Der Codeausschnitt befindet sich in der Datei

RolliApp/src/de.stapelfeldtonline.rolliapp.clock/StopWatch.java.

private void updateGui() {

long elapsedTime = getElapsedTime();

long minutes = (elapsedTime / 60000) % 60;

long hours = (elapsedTime / 60000) / 60;

CharSequence timeString = String.format("%02d", hours) + ":" +

String.format("%02d", minutes);

if (sinceStartTextView != null) {
sinceStartTextView.setText(timeString);

}
}

public void run() {

updateGui();

handler.postDelayed(this, REFRESH_TIME);

}
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Die Methode updateGui ist fur die schlussendliche Darstellung der

,Zeit seit Start” zustandig. Hierflir wird zundchst der Long-Wert elapsedTime er-
zeugt und diesem der Wert der Methode getElapsedTime zugewiesen. Daraufhin
wird der Wert, der urspriinglich in Millisekunden vorliegt, entsprechend umge-
rechnet und jeweils wiederum als Long-Werte minutes beziehungsweise hours
gespeichert. SchlieRlich werden die Werte formatiert, dem Charsequence-Objekt

timeString zugewiesen und auf die Textview sinceStartTextView angewendet.

Die Methode getElapsedTime wurde umgesetzt, um bei einer Unterbrechung der
Messung zu erreichen, dass fiir die Berechnung die Unterbrechung nicht stattge-

funden hatte.

Die Methode run, die wiederum die Methode updateGui aufruft, wird minttlich

ausgefihrt.
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3.10 Verschiedenes

Zum einen handelt es sich um den sogenannten Locationmanager, der fiir die
Kommunikation mit dem GPS-Empfanger verantwortlich ist. Zum anderen wird
am Beispiel des Wertes fir die zurlickgelegte Strecke der Speicher- und Ladevor-
gang beschrieben. Hierbei wird der Locationmanager lediglich in der Datei
RolliApp/src/de.stapelfeldtonline.rolliapp/Main.java erzeugt. Demgegeniber er-
folgte die Umsetzung des Speicher- und Ladevorgangs in der Datei

RolliApp/src/de.stapelfeldtonline.rolliapp/Storage.java.

locationManager = (LocationManager)

getSystemService(Context.LOCATION_SERVICE);

locationManager.requestLocationUpdates(LocationManager.GPS_PROVIDER, 0,

0, locationListener);

Zunachst wird das Locationmanager-Objekt locationManager erzeugt und diesem
der Dienst LOCATION_SERVICE des Betriebssystems zugewiesen. AnschlieRend
wird regelmafig mit Hilfe der Methode requestLocationUpdates, ohne dass eine
bestimmte Zeit und Distanz vergangen beziehungsweise zurlickgelegt sein muss,

eine Aktualisierung des Aufenthaltsorts durchgefiihrt.

public void savePreferences() {

float distanceCovered = remainingDistanceCalculator.getCoveredDistance();

savePreferences(COVERED_DISTANCE, distanceCovered);

}
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public void loadPreferences() {

SharedPreferences sharedPreferences =

activity.getPreferences(Context. MODE_PRIVATE);

if (sharedPreferences.contains(COVERED_DISTANCE)) {
float coveredDistance = sharedPreferences.getFloat(COVERED_DISTANCE, Of);

remainingDistanceCalculator.setCoveredDistance(coveredDistance);

}
}

Um den Float-Wert fiir die zurlickgelegte Strecke zu speichern, wird diesem in-
nerhalb der Methode savePreferences der entsprechende Wert aus der Methode
getCoveredDistance aus dem ,remainingDistanceCalculator” zugewiesen. An-

schliefend wird der Wert unter dem Eintrag COVERED_DISTANCE gespeichert.

Schlief3lich sorgt die Methode loadPreferences dafiir, dass der entsprechende
Wert wieder geladen wird. Falls die sogenannten sharedPreferences den Wert
COVERED_DISTANCE enthalten, wird er wieder ausgelesen, dem Float-Wert
coveredDistance zugewiesen und mit Hilfe der Methode setCoveredDistance im

»remainingDistanceCalculator” weiterverwendet.
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3.11 Verdéffentlichung im Android Market

Der erste Schritt besteht aus dem Signieren. Das ist erforderlich, da Android auf-
grund der Vertrauenswiurdigkeit voraussetzt, dass jede zu installierende App sig-
niert sein muss. Durch das Zertifikat ergeben sich jedoch weder fir den Entwick-
ler noch fiir den Nutzer einer App Nachteile. Das bedeutet, dass das Zertifikat
durch den Entwickler ausgestellt werden kann und dass durch das Zertifikat nicht
geregelt wird, ob eine App installiert werden darf oder nicht (Android.com L). So-
bald die Entwicklung einer App abgeschlossen ist, bieten die ADT eine einfache
Moglichkeit, um den Exportprozess, der unter anderen das Signieren umfasst,
durchzufiihren. Zunachst muss in Eclipse ,File>Export” ausgewahlt werden. Der
Export, fir den die Auswahl des Projekts und die Erzeugung des Keystores erfor-
derlich ist, ist daraufhin unter ,,Android>Export Android Application” zu finden
(Android.com M).

Der nachste Schritt besteht in der Versionierung. Sie ist ebenfalls nur fiir den Ent-
wickler beziehungsweise Nutzer zum Beispiel aus Griinden der Kompatibilitat re-
levant und hat ebenfalls keinen Einfluss auf die Installation (Android.com N). Die
Informationen Uber die Version einer App werden in der Datei
AndroidManifest.xml, die jedes Android-Projekt beinhaltet, angegeben. Zum
einen steht das Attribut android:versionCode in keinem Zusammenhang mit der
Version, die dem Nutzer angezeigt wird. Es dient lediglich dazu, den aktuellen
Entwicklungsstand einer App festzustellen und sollte mit dem Wert eins begin-
nend bei jeder weiteren Verdéffentlichung monoton erhoht werden. Zum anderen
wird durch das Attribut android:versionName dem Nutzer die Version der App

zum Beispiel im Android Market angezeigt (Android.com O).
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SchlieBlich kann die App nach der in Kapitel 2.3 erwdahnten Registrierung und der
Angabe folgender Informationen unter , http://market.android.com/publish”

hochgeladen und veréffentlicht werden:

* Mindestens zwei Screenshots

* Ein hochauflésendes Icon fir die Darstellung im Android Market
* Sprache

* Name

* Beschreibung

* App-Typ

* Kategorie

* Bewertung des Inhalts

* Preis

In Abbildung 12 ist schlieRlich die Veroffentlichung von RolliApp abgeschlossen:

Abbildung 12: RolliApp veréffentlicht
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4 Evaluation

Um schlieB8lich die Umsetzung der streckenbezogenen Funktionen auf eine kor-
rekte Funktionsweise hin zu verifizieren, wurde eine Versuchsreihe durchgefihrt.
Dabei dienten die Stationszeichen, die an Bundes- und LandesstraBen jeweils im
Abstand von 200 Metern aufgestellt sind, als Messpunkte, zwischen denen der
Abstand mit Hilfe von RolliApp gemessen wurde. Zusatzlich wurde die Abwei-
chung berechnet. Die Versuche wurden lediglich mit einem Testgerat durchge-
fahrt, da zum einen kein weiteres zur Verfliigung stand und zum anderen die Un-
genauigkeit des GPS-Signals ohnehin entweder von den Satelliten oder dem GPS-

Empfanger ausgeht und immer unbeeinflussbar auftreten wird.

Versuch Tatsdchliche Strecke | Gemessene Strecke in | Abweichung in %
inm m

1 200 211 5,5
2 200 198 1

3 200 203 1,5
4 200 199 0,5
5 200 198 1

6 200 195 2,5
7 200 198 1

8 200 204 2

9 200 202 1
10 200 204 2
Durchschnittliche Abweichung 1,8

Tabelle 3: Evaluation der streckenbezogenen Funktionen
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5 Fazit

Das Ziel, das sich der Autor dieser Masterarbeit gesetzt hatte, konnte mit Hilfe
des entwickelten Prototyps erreichet werden. Fahrer von elektrischen Rollstiih-
len ist es nun grundlegend moglich festzustellen, welche, zuvor selbst definierte,

Reichweite noch zuriickgelegt werden kann.

Die Berechnung der verbleibenden Reichweite erfolgt beim fiir das Smartphone-
Betriebssystem Android entwickelten Prototyp durch GPS und kann, wie in
Kapitel 6 beschrieben, zukiinftig um eine Kalibrierung erweitert werden. Der Pro-
totyp wurde sowohl im Emulator innerhalb der Entwicklungsumgebung Eclipse
als auch anschlieBend auf dem Smartphone des Autors unter realen Bedingun-
gen erfolgreich getestet (siehe Kapitel 4). SchlieRlich wurde RolliApp im Android
Market veroffentlicht und kann von jedem Nutzer, der die entsprechenden Vor-

aussetzungen erflllt, kostenlos heruntergeladen werden.
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6 Ausblick

Wie bereits in Kapitel 2.1 erwdhnt wurde, bietet RolliApp derzeit keine Moglich-
keit, die Alterung des Akkus des elektrischen Rollstuhls zu registrieren. Der Nut-
zer muss vielmehr die Einstellung fir die verbleibende Reichweite manuell an-

passen.

Ein moglicher Losungsansatz konnte so aussehen, dass die App die Anpassung fiir
den Nutzer Gbernimmt. Der Vorgang kénnte beispielsweise beim Zurilicksetzen
der verbleibenden Reichweite erfolgen. Zusatzlich miisste jedoch ein Schwellen-
wert von beispielsweise drei Kilometern angegeben werden, damit die Anpas-
sung nicht auch bei aus Vorsicht zuriickgesetzter verbleibender Reichweite statt-

findet. Weiterhin sollte der Nutzer den Vorgangen zustimmen.
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Anhangsverzeichnis

Auf dem beigefligten Datentrager befindet sich neben der digitalen Version die-
ser Masterarbeit (Stapelfeldt_Oliver_111123.pdf) das Eclipse-Projekt. Nach dem
Dekomprimieren der Datei RolliApp.zip kann das komplette Projekt entweder
wie in Kapitel 2.5 beschrieben importiert oder die relevanten Dateien mit Hilfe

eines Texteditors betrachtet werden.
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